
Special Services
This section covers the following topics:

Invoking the Special Services Menu

Importing Users

Importing Files

Modifying Multiple Users

Layout Standard Title

JCL Members

Invoking the Special Services Menu
 To invoke the Special Services menu:

Issue the SPECIAL command from theObject List screens.

Or: 

Choose the object Special Services on theAdministration Menu.

The Special Services Menu appears:
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 14:52                      ***** Super Natural *****                 1999-05-21
 SBE                        - Special Services Menu -                      SNM14
                                                                   More:     +  
                                                                                
                                                                                
              IM USER Import Users                                              
              IM FILE Import Files                                              
                                                                                
              MULT    Modify Multiple Users                                     
                                                                                
              TITL    Layout Standard Title                                     
                                                                                
              JCL     JCL Members                                               
                                                                                
              PROC    Super Natural Processor                                   
                                                                                
                                                                                
                                                                                
                                                                                
                                                                                
 Select Object                                                                  
 Command ===>                                                                   
 Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
       Help        Exit              Flip                                Canc

Importing Users
When Super Natural is operating under theNatural Security system, you can use theImport User function instead of
theAdd User function to define users.

Note: 
The Import function is only useful for users of Natural Security.

In order to import file profiles, the applicationSYSSN must be people-protectedunderNatural Security.

To import users with private files, the private files must be linked to the application SYSSN.

 To import users:

1.  Issue the IMPORT USERname command.

Or: 

Issue the IMPORT USER command.

The Import User screen appears as in the following example:
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 14:53                      ***** Super Natural *****                 1999-05-21
 DBA                             - Import User -                           SNMUI
                                                                   More:     +  
                 User ID   Private Files                                        
                 *_______                                                       
              _  ANS                                                            
              _  APAXF                                                          
              _  AZE                                                            
              _  AZE1                                                           
              _  AZE5                                                           
              _  BBU                                                            
              _  BBUBAT                                                         
              _  BBUUSER1                                                       
              _  BGW                                                            
              _  BKA                                                            
              _  BSE                                                            
              _  BTO                                                            
              _  BVUS                                                           
              _  CF                                                             
                                                                                
 Mark users to be imported into SYSSN                                           
 Command ===>                                                                   
 Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
       Help        Exit              Flip        +                       Canc

The screen lists the users defined under Natural Security and displays the number of private files for each user.

If you specified a user name, the list starts from that name. 

Natural Security users of the typesTerminal and Group are not listed.

2.  Mark the users to be imported. 

3.  Press Enter.

The users’ private files are added/linked automatically, if they are not yet defined to Super Natural. 

Users already defined to Super Natural are shown on the list, but can not be marked.

Importing Files
When Super Natural is operating under theNatural Security system, you can use theImport File function instead of
theAdd File function to define users. You can import both private and public files. 

Notes:

1.  The Import function is only available for users of Natural Security. 
2.  In order to import file profiles, the applicationSYSSN must bepeople-protectedunderNatural Security. Private

files must be linked to the application SYSSN.

 To import a file:

1.  Issue the IMPORT FILEname command.

Or: 

Issue the IMPORT FILE command.
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The Import File >Private screen appears as in the following example:

 14:54                      ***** Super Natural *****                 1999-05-21
 DBA                        - Import File  >Private -                      SNMFI
                                                                                
                 File Name                         Type                         
                 *_______________________________                               
              _  CO-AGREEMENT                      Priv                         
              _  COMMAND-SSZ                       Priv                         
              _  UF-SEK-BSP51                      Priv                         
              _  UF-SEK-BSP6                       Priv                         
              _                                                                 
              _                                                                 
              _                                                                 
              _                                                                 
              _                                                                 
              _                                                                 
              _                                                                 
              _                                                                 
              _                                                                 
              _                                                                 
 >Public                                                                        
 Mark files to be imported to SYSSN                                             
 Command ===>                                                                   
 Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
       Help        Exit              Flip        +                       Canc

The screen lists the private files that are already linked to the application SYSSN. 

Files already defined to Super Natural are shown on the list, but an not be marked. 

2.  If you want to import a public file, issue the>PUBLIC command.

The Import File >Public screen appears. The screen lists the public files that are already linked to the
applicationSYSSN. Files already defined toSuper Natural are shown on the list, but can not be marked.

3.  Select the file(s) to be imported. 

4.  Press Enter.

The file(s) are imported and the Modify File >Options screen for the first file selected appears.

5.  Modify the file options as described in the section Files earlier in this documentation if required.

Modifying Multiple Users
You use the Modify Multiple Users function (called Mass Change in previous versions ofSuper Natural ) to unify the
options of multiple (or all) users.

 To modify multiple users:

1.  Issue the MULTIMOD command.

The Modify Multiple Users window appears:
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 11:08                      ***** Super Natural *****                 1999-05-24
                            - Special Services Menu -                      SNM14
                                                                                
                                       +---------Modify Multiple Users---------+
                                       !                                       !
              IM USER Import Users     ! Enter a user ID to get the options of !
              IM FILE Import Files     ! this user as default options.         !
                                       ! If using ’*******’ you will get the   !
              MULT    Modify Multiple  ! global options as default.            !
                                       !                                       !
              TITL    Layout Standard  ! User ID: _______                      !
                                       !                                       !
              JCL     JCL Members      +---------------------------------------+

2.  Enter the user ID whose options you want all or multiple users to get.

The Multiple Modify Multiple Users >Optionsscreen appears:

 11:11                      ***** Super Natural *****                 1999-05-24
                        - Modify Multiple Users >Options -                SRMUQO
                                                                                
                                                                                
              _  Maintenance Authorization / Language / Prefixes                
                                                                                
              _  Sizes / Numbers / User Files                                   
                                                                                
              _  Database Access                                                
                                                                                
              _  Database Access and JCL                                        
                                                                                
              _  Data Maintenance Transaction Type / Data Selection             
              _  Report Type / Report Level                                     
              _  Report Destination / Run Mode / Batch Job Entry                
                                                                                
              _  Display Options                                                
                                                                                
                                                                                
 >Users                                                                         
                                                                                
 Command ===>                                                                   
 Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
       Help        Exit              Flip                                Canc

3.  Modify the user options as described in the section Modifying Single Users earlier in this section if required. 

4.  Select >Users.

The Modify Multiple Users >Users screen appears as in the following example:
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 11:12                      ***** Super Natural *****                 1999-05-24
                         - Modify Multiple Users >Users -                 SNMUQL
                                                                   More:     +  
       User ID                                                                  
       *______                                                                  
    _  *******          _  AA92             _  CALL ’C          _  DP           
    _  A                _  AA93             _  CCA              _  DS           
    _  AA               _  AA94             _  CCH              _  DW           
    _  AA1              _  AKR              _  CF               _  ESC          
    _  AA2              _  ALO              _  CHEF             _  EZA          
    _  AA3              _  AS               _  CMR              _  FHA          
    _  AA4              _  AZ               _  CR               _  FK           
    _  AA5              _  A1               _  DA               _  FS           
    _  AA6              _  BF               _  DBA              _  FSO          
    _  AA7              _  BFA              _  DEMO             _  FT           
    _  AA8              _  BFB              _  DEMO1            _  GAS          
    _  AA9              _  BFC              _  DEMO2            _  GBAH         
    _  AA91             _  BS               _  DOG              _  GBBW         
                                                                                
                                                                                
 Mark users for function Modify Multiple                                        
 Command ===>                                                                   
 Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
       Help        Exit              Flip        +                       Canc

5.  Mark the users you want to give the new user options.

Marked users are modified when you do one of the following:

Issue a paging command.

Press Enter.

Press PF3. 

Layout Standard Title
You use the Layout Standard Title function to edit the standard Title element which is generated for all reports at
your site. For example, you may want the name of the company to appear at the top of all reports. Users can edit the
Title element in each report.

Editing the Layout Standard Title Element

 To edit the standard Title layout element:

1.  Issue the TITLE command.

The Layout Editor appears with the Standard Title element currently defined at your site in the editor area. 

2.  Edit the Standard Title as described in the section Natural Report Managerin the Super NaturalUser’s Guide.
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Super Natural provides the following default Standard Title element:

System Variables

The Natural system variables available in Super Natural are listed in the Transaction Fields section of the split-screen
Layout Editor. For further information on system variables, see System Variables in the Super Natural User’s Guide. 

S Lines

The S lines are a placeholder for up to 5 lines of selection criteria. Each S line contains 60 Ss. If you either add or
erase Ss from the S lines, the Ss are interpreted as text. You can edit the S lines if you wish, for example, you can
move them two lines down and enter text above them.

Deleting the Standard Title

You can delete the contents of the Standard Title member in the Super Natural Administration application. The next
time you choose Layout Standard Title from the Special Services menu, the Layout Standard Title window appears
where you can choose between editing the empty Standard Title and regenerating theSuper Natural default Standard 
Title.

You can delete the Standard Title member in SYSSN, however it is regenerated the next time a layout is generated
for a transaction.

JCL Members
You use the JCL Members function to maintain JCL members using the Natural LIST command. By default, each
JCL member is stored in library ZJCL. Choosing JCL Members from the Special Services menu is the same as
issuing the following Natural commands:
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LOGON LIBRARY ZJCLLIST *

A user can only have access to one JCL at a time. However, you may create several JCL’s in the library ZJCL. You
can change user access to JCLs as necessary using user options.

You can perform the following commands on JCL members:

 DELETE EDIT LIST PRINT RENAME

JCL Member X X X X X

Although other commands are available using the NaturalLIST command, these are the only commands necessary
for JCL member administration.

For further information on using Super Natural in Batch Mode, seeBatch Processing.

The library ZJCL should only be used for storing JCL members.

Invoking the JCL Members Function

 To invoke the JCL Members function:

1.  Issue the JCL command.

You have now accessed the Natural LIST command. The Natural LIST COMMAND LIST P * screen appears
as in the following example:

 14:59:24               ***** Natural LIST COMMAND *****              1999-05-21
 User SBE             LIST P *                                  Library ZJCL    
                                                                                
                                                                                
 Cmd  Name      Type         S/C  SM  Vers  Level  User-ID   Date      Time     
 ---  --------  -----------  ---  --  ----  -----  --------  --------  -------- 
 __   JCLCF     Program      S    R   2.2   0004   CF        92-12-21  11:30:22 
 __   JCLHAH    Program      S    R   2.2   0005   HAH       93-05-17  14:51:53 
 __   JCL01     Program      S    R   2.2   0003   AR        92-06-11  18:14:13 
 __   JCL02     Program      S    R   2.2   0003   WRKMKO    92-09-18  14:07:28 
 __                                                                             
 __                                                                             
 __                                                                             
 __                                                                             
 __                                                                             
 __                                                                             
 __                                                                             
 __                                                                             
 __                                                                             
 __                                                                             
 From ________ (New start value)                                 4 Objects found
 Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
       Help        Exit              --    -     +                       Canc   

Deleting JCL Members

 To delete a JCL member
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1.  Enter DE in the command column next to the JCL member you want to delete.

2.  Confirm the deletion in the window which appears.

The JCL member is deleted.

Editing JCL Members

 To edit a JCL member

Enter ED in the command column next to the JCL member you want to edit.

The Natural Program Editor appears where you can edit the JCL member. For information on editor handling,
see the Natural Reference documentation.

Listing JCL Members

 To list a JCL member

Enter LI in the command column next to the JCL member you want to list.

The JCL member is displayed in the Natural Program Editor. For further information on the Natural Program
Editor, see the Natural Reference Documentation.

Printing JCL Members

 To print a JCL member

Enter PR in the command column next to the JCL member you want to print.

The JCL member is printed.

Renaming JCL Members

 To rename a JCL member:

1.  Enter RE in the command column next to the JCL member you want to rename.

2.  Type a new name in the window which appears.

JCL member names can have 1 to 8 characters.

3.  Press Enter.

The JCL member is renamed.

For further information on the NaturalLISTcommand, see the Natural Reference documentation.

Writing JCL Members

For information on creating JCL members, see Writing JCL ProceduresinBatch Processing.
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